Final Cut Pro 6 Workshop
http://www.cla.purdue.edu/vpa/etb/
Fabian Winkler

Required software/supplies for this workshop:

Description

Apple Final Cut Pro
http://www.apple.com/finalcutstudio/finalcutpro/

External hard drive, preferably FireWire
www.lacie.com

Digital video recorded onto Mini DV tape

Mini-DV playback device (either camera or mini-DV deck
connected to computer via FireWire cable)
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Final Cut Pro 6 Workshop

=

Final Cut Pro

Final Cut Pro (FCP) is a powerful software package that allows the non-linear editing of
digital video. Non-linear editing refers to a process of assembling your final video in
which you can combine clips without following a linear order. This technique is quite
different from traditional analog video editing in which the sequence of clips couldn’t be
changed easily without starting from the beginning again.

For all question related to Final Cut Pro that we cannot address in class please consult
the excellent FCP help:

Help > Final Cut Pro User Manual..

In the following pages | introduce techniques for working with SD AND HD video.
Some of the numbered steps below are the same for SD and HD but some require
different settings. whenever this is the case | indicate the individual steps with
“SD” and “HD” for each video format.

Starting a new project

1. Create a new folder - either in your home directory or desktop if you have a USB
external hard drive. Or directly on your Firewire hard drive (preferred).

2. Open up Final Cut Pro. When you open the application for the first time you will see a
window similar to this:

Choose Setup

Format: | NTSC ﬂ Rate: | 29.97 fps '+
Use: | DV-NTSC B

Use this Easy Setup when working with DV NTSC source material and using
FireWire for input/output of audio and video with Device Control set to FireWire.

Sequence Preset: DV NTSC 48 kHz

Capture Preset: DV NTSC 48 kHz

Device Control Preset: FireWire NTSC

Playback Output Video: Apple FireWire NTSC (720 x 480)
Playback Output Audio: FireWire DV

Edit to Tape/PTV Output Video: Same as Playback

Edit to Tape/PTV Output Audio: Same as Playback

Primary Scratch Disk: | Macintosh_HD ﬂ

SD: Make sure to choose Format: NTSC, Rate: 29.97fps and Use: DV-NTSC. Don’t worry
about the Primary Scratch Disk. We will set it manually in the next step.
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HD: When you use the Canon VIXIA HF S100 the setup of your project depends on the
recording setting you chose in the camera. Assuming you set the camera to the highest
possible quality (1080i60) the settings for Final Cut would be:

Format : HD

Use: HDV — Apple Intermediate Codec 1080i60

3. Final Cut Pro opens. The first thing you should do is to save this project (even though
there is nothing in it yet). This will facilitate finding files later and it also enables the FCP
auto-save feature.

File > Save Project As..

Make sure to save the project in the folder that you created previously.

4. Setting the Scratch Disks (this is where FCP will store your digitized files)
Final Cut Pro > System Settings..

You will get a window like this:

System Settings

Scratch Disks ', Search Folders |, Memory & Cache | Playback Control | External Editors \ Effect Handling |

Video Audio Video Audio
Capture Capture Render Render

™ v & ( Set.. ) 2.3 GBon Macintosh_HD:Users....s:Final Cut Pro Document m
o€t J
Set... ) <None Set>

<None Set>

<None Set>

D Capture Audio and Video to Separate Files

Waveform Cache: Set--—9 2.3 GB on Macintosh_HD:Users:fwinkler:Documents:Final Cut Pro Documents
N
Thumbnail Cache: Set... ) 2.3 GB on Macintosh_HD:Users:fwinkler:Documents:Final Cut Pro Documents
N
Autosave Vault: [ Set.. ) 2.3 GB on Macintosh_HD:Users:fwinkler:Documents:Final Cut Pro Documents
N o/
Minimum Allowable Free Space On Scratch Disks: 2047 MB
(] Limit Capture/Export File Segment Size To: | 2000| MB
(] Limit Capture Now To: | 30| Minutes

( cancel ) ( OK )

Press the Set... Button in the first row and make sure that you choose the same folder
in which you also saved your project previously (this will ensure that you keep all your
files - project files and linked media files together).

5. The final Cut Pro User interface is comprised of a combination of different windows.
Here is what they are good for (see also screenshot on the following page:

(1) Browser: this is where all your media files (sounds, still images and digitized videos)
will go. You can further organize them in the Browser by creating “bins” which act as
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folders for materials that belong together. Bins do not server a technical purpose. They
are just tools to keep your files organized. The Browser also gives you access to video
and audio effects some of which we will take a look at later.

(2) Viewer: if you double-click on a digitized video in the Browser it will open in the
Viewer window, so that you can preview it. Use the controls at the bottom of the window
for playback.

(3) Timeline: when you create a video in FCP you assemble it in the timeline, which
allows you to arrange your clips in time, one after another. Just drag a clip from the
Viewer window in the Timeline. The transition from one clip to another is called “edit” or
“cut” - we will talk more about editing techniques in the following workshop.

(4) Canvas: Once you are working with clips in the timeline they will show up in the
Canvas window. The Canvas window has similar controls compared to the Viewer. You
can use them to playback you final video.

(5) Tools Palette and Audio Meter: you can use the tools in the Tools Palette mainly for
editing purposes (we will work with them later in the next workshop). The Audio Meter
shows you the audio level of your recorded footage. You can adjust it manually if
needed.

@ Final CutPro File Edit View Mark Modify Sequence Effects Tools Window Help Q

OO Browser OIS Viewer: Slug [eTala) Canvas: Sequence 1 in Untitled Project 1 |
Untited Project 1\ Effects Video | Stereo (a1a2) | Filters | Motion Sequence 1 |

¥ [Duration [In [out [Mediastart | <% [“o0.0010:00 ) WY 0 €73 [ 00:00:00:00] | €35 [ 00:00:0000 ) WY 0 €73 [ 01:00:00,00

& Name
[ Jseauence 1] 0000000 MotSer  NotSer  0100000C

DRI

olcjololany ) Gl ()

D500 Timeline: Sequence 1 in Untitied Project 1 Jo_Jo
TG (s ||
_RT5) [ 01:000000 5o 1:00:04;00 1:00:16,00 1:00:28:00 =4

@ (1) a 6

@A) @

@ (2 (A) a8

@ (m)a

@ ()3
o|=| Av[agm» o[« [ mpY

6. Digitize videos from your mini-DV playback device or HD flash memory camcorder.
SD (for HD jump to the bottom of step 7): Make sure the mini-DV deck or camera is
connected to your computer with a firewire cable (FCP will give you a warning message
on startup if it cannot find the external playback device) or if you have an external
miniDV playback device (like the ones in STEW B31) use this instead.

Then open the Log and Capture window:

File > Log and Capture..
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000 Log and Capture
Total Free Space 3.7 GB Total Free Time (AV) 16.6 min Logging ‘ Clip Settings '( Capture Settings

@4 00:00:00;01 @ 00:00:12;00 Log Bin: 0 @
‘ Reel: [001 )
Name: 8 Prompt
Description: | ‘@‘%ﬁ
Scene: | @ e
Shot/Take: | & v
Angle: | @ ||-7
Log Note: e
I » Markers:
)
110 o R
Y9e00L
1G] 2000 1200 ) o ()] 9000 12 00| ket I cio I vow I sscn )

Use the controls to playback your video. You can use your keyboard keys “< (home)” and
“(end) >” to cue the video frame by frame. Once you have reached the starting point
from where you would like to digitize press the “i” key on your keyboard or set an in
point by clicking (1).

Now cue the video to the outpoint, where you would like to stop recording:

000 Log and Capture
Total Free Space 3.7 GB Total Free Time (AV) 16.6 min Logging ‘ Clip Settings ‘ Capture Settings |
75| 00:00:12:24 £ | 00:00:24:23 Log Bin: 0 @

Reel: [001

Name: ,_|_ M Prompt
Description: [
Scene: [
Shot/Take: |
Angle: [

Log Note:

(L)

NSNS

-
g

(

I » Markers:

)] 00.00.12.00 () ()] 0002423 )| teacie JRIL cio IR vow IR such )
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Set an out point by clicking (2) or press the “0” key on your keyboard. Now you need to
“log” the clip, i.e. add it to a list of clips with their corresponding in and out points that
the computer should remember.

Press Log Clip (3) in the Log and Capture window and give the clip a descriptive
name. This will later on be the clips file name after it has been digitized

Total Free Space 3.7 GB Total Free Time (AV) 16.6 min Logging | Clip Settings | Capture Settings

(5[ Goanizae S 0033 | igan (sl D @ 6
Log Clip @
! E Prompt
Name:[DIELECTRIC_Wood_S¢ () @~
I
Log Note: [~ Mark Good ) :
%
@ v
— Good

|

1110 0 O O O o 5 5

169 000012000 ()] 00002623 [(ug) [ teactie JRIIC cip IR Now JI emch IR

You can repeat these steps (cueing, setting in point - cueing setting out point - logging
clip) for as many clips as you would like to digitize.

7. Capture the logged clips with Batch Capture: after you have logged all the clips you
would like to digitize, press the Batch button (4) in the Log and Capture window. You
should get a window like the one on the following page.

Make sure to check: Capture: All Items in Logging Bin if you do not have
any other already digitized clips in your Browser. Or check: Capture: Selected
Items in Logging Bin if you have already digitized some clips and would like to
add the logged clips to them.

Double-check the Capture Preset, it should be set to “DV NTSC 48kHz”
The bottom of the Batch Capture window gives you an estimate of how much space the

digitized files will take up on your hard drive and how this amount of data translates to
the actual time of video recorded.
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00  Not Set Not Set 01:00:
Batch Capture

Capture: | All Items in Logging Bin

Total Free Space) 3.7.GB Options: M Use Logged Clip Settings

c4: [ 00:00.00:00

["] Add Handles: [

Capture Preset: | DV NTSC 48 kHz

Using DV Video for video input
DCR-TRVI00 using NTSC
29.97 frames per second

DV - NTSC at Best quality. ;‘J
24 bits per pixel [
720 by 480 v

Using DV Audio for audio input

Input: First 2 channels

Speaker: off

Volume: 100, Gain: 0

Using logged clip settings for picture, gain, and
media to be captured.

W

Total Media Time: 00:00:12:24

Total Disk Space: 49.7 M8 needed / 3.7 GB available

)| 0002425 ()

Once you press “OK” the computer takes over and automatically cues the tape to the
relevant positions and digitizes your clip(s).

@ Final CutPro File Edit View Mark Modify Sequence Effects Tools Window Help
B 000 Viewer: DIELECTRIC_Wood_St in Untitled Project 1 OO0
Untited Project 1\ detroit docu | Effects i 5 EESREERNY Sequence | 0

Name [uration | n Jous s media | 35 00001224 €73 [ 00001200 | i [o000.00.00 €3 [ o1:00:00,00

&
[~ JoreLecTRiC Wood st 00:0012:24  Not Set Not Set
[E5] Seauence 1 00:00:00.00  Not Set Not Set

RN 01:00:00:00 5575 01:00:04:00 01:0008:00 01:00112:00 01:0016:00 01:00:20:00 01:00124:00 01:00:28:00 01:00132:00

0
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HD: Connect your camera with a USB cable to the computer. Turn the camera on. Open

the Log and Transfer window

File > Log and Transfer..

00600 Log and Transfer
(e2) (2] @ == (%~ €3 00031021 Clip #1 €3 ["00:01:08:28
"Name T " Volume [MediaStart | Media Duration
O cip#1 - Untitled 00:00:00,00 | 00:03:1021 M
O Clip#2 - Untitied 00:00:00;00  00:00:10;00
O Clip#3 - Untitied 00:00:00;00  00:01:25;17
O Clip#4 - Untitied 00:00:00;00  00:01:00;02
O Clip#s - Untitied 00:00:00;00  00:01:04;02
O Clip#6 - Untitled 00:00:00;00  00:01:21;17
O Clip#7 E Untitled 00:00:00;00  00:02:45:04
O Clip#8 - Untitled 00:00:00;00  00:02:01;19
| i |
O Clip#9 m Untitled 00:00:00;00  00:00:47;15
J PoEG®
O Clip#10 - Untitled 00:00:00;00  00:00:52;00 =
- () - Add Clip to Queue - (i)
O Clip#11 - Untitled 00:00:00;00  00:00:25;15 )|
v
— Logging | Import Settings
] O [E] 2 s~ 1 013 s
Reel: ' Untitled ~) -
SIGGRAPH_digitize 0 clips queued - Idle. 1) L)
Name: Clip #1 -]
Scene: [+)
Shot/Take: [-)(e9)
Angle: [-]
Drag media here.
Log Note: [ Good
Gl—e—M& Total Free Space: 10.2 G&

You will see all the clips that have been recorded on your flash drive in the box on the
top left side of your window. You can select multiple clips by holding down the
command key while clicking. Once you selected all the clips click on the “Add selection
to queue” button. Log and Transfer should start automatically - you can see a progress
bar on top of the lower left box in the Log and Transfer window:

® @ > DG

7(

| Add Clip to Queue | u m [ Notset]

i

Logging | Import Settings |

O Clip #6 - Untitled 00:00:00;00 ' 00:01:21:17
O Clip#7 E Untitled 00:00:00;00  00:02:45:04
O Clip#8 - Untitled 00:00:00;,00  00:02:01;19
O Clip#9 m Untitled 00:00:00;00  00:00:47:15
O Clip#10 - Untitled 00:00:00;00  00:00:52;00
O Clip#11 - Untitled 00:00:00;00  00:00:25;15 b
— b
——©— [&] 13 selected - 1v... 13 clips displayed
SIGGRAPH_digitize __lips queued - Transferring Clip#1... Feeer ][ Il
i Status  Name In i Out i Duration
O Clip #1 00:00:00;00  00:03:10:20  00:03:10;21 m
- Clip #2 00:00:00;00  00:00:09:23  00:00:10;00

Reel: ' Untitled

Name: Clip #1

Scene:
Shot/Take:

Angle:

[-) ()

[ ()

[-) (=)

[-)(e2)

(=)

If Log and Transfer does not start automatically you have to press the pause/play button

next to the progress bar.
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In this process of Log and Transfer, the clips recorded on the video camera’s flash
memory are being encoded with the Apple Intermediate codec and transferred into the
Capture Scratch folder in your Scratch Disk location.

8. After the computer has digitized your materials you should see them in your Browser
window. Double-clicking on one of these clips will open it in the Viewer so that you can
take a look at it.

Important: all the digitized clips have been saved automatically to the Capture
Scratch folder in your original folder that you created at the beginning of this
workshop. You will find another folder with the project’s name in the Capture
Scratch folder and in there you will see all your digitized clips as Quicktime movies
with the names you gave them when logging them. Final Cut Pro does not import
these Quicktime files into your project but just links to them. This means that the
relative path between these Quicktime files and the project file has to stay the
same, otherwise FCP cannot locate the media files anymore. Working out of one
folder that stores all the files should prevent his from happening.

9. The first step toward editing is to drag the clip from the Viewer into the Timeline. The
clip will appear in the Canvas window and you are ready for your first edit. This will be
the topic of workshop 02...

@ Final CutPro File Edit View Mark Modify Sequence Effects Tools Window Help

Sequence 1 Sequence 1

[l
€73 00002125 | €% ["0000.0604 ST €73 [ 01000604

00:00:06:04  00:00:15:22  00:00:2125  00:00:
00:00:06:04  Not Set Not Set 01:00:

Timeline: Sequence 1 in Untitled Project 1

(=

" Sequence 1| Sequence 1
@RI\ _01:00:06:04 [f55iGo 01:00:04:00 01:00'08:00 01:00112:00 01:0016:00 01:00:20,00 01:00:24:00 01:0028:00
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